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Chapter 39: Playback

Playback Controls
How to get there
Choose Playback Controls from the Window Menu.

What it does
Playback Controls is a docked toolbar or floating window that give you tape-deck–like buttons for 
controlling the playback of your score. Click on the Playback Settings button to open the Play-
back Settings dialog box where you can specify a number of playback options, such as the tempo, 
range of measures to be played, overall volume level, and so on. Also, Playback Settings let you 
save a MIDI or playback file, and give access to the Playback Options dialog box, where you can 
further specify Finale’s playback behavior.

Playback Controls supports Finale’s HyperScribe recording and playback functions as well. To 
start recording, you can click Record in Playback Controls when the HyperScribe Tool is selected. 

• Rewind to Beginning ,,,,. Click this button to enter the number 1 into the Measure text box, 
which indicates where playback will begin. If the music is already playing back when you 
click this button, Finale will stop playback for a moment, jump to the beginning of the score, 
and resume playback from there.

• Rewind 3333. Click this button and hold the button down to make the number in the Measure 
text box decrease rapidly. If the music is already playing back and you want to hear something 
again, click this button for a moment, then release; playback will resume from the measure 
number (that you just changed) in the Measure box.

• Stop 8888 • Play 7777 • Pause 0000.   Click Stop to halt playback and reset the Measure text box to its 
original value (or, rather, to the value indicated by the Play From controls; see below).

Click Play to begin playback. While the music is playing, the Measure text box shows you the 
measure being played. If you click Pause, playback will stop and the Measure text box will 
show the measure you stopped at. After you click Pause, click Play to resume playback from 
the place you stopped.

• Record 9999. Click Record to start recording when HyperScribe is the selected tool. Be sure that 
you have specified a staff for recording into in the Instrument List window. Based on your set-
tings in the Click and Countoff dialog box, Finale will either start recording immediately, or 
after playing the indicated number of countoff measures. Unless you’re tapping to provide the 
beat (Tap is checked in HyperScribe’s Beat Source submenu), Finale will wait for the start sig-
nal you selected in the Playback and/or Click dialog box before playing the countoff measures 
and recording your performance. 
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Note: As a shortcut you can click a measure in your score to start recording, instead of using 
the Record button. Finale will start recording into the measure you clicked, according to the 
click and countoff settings, just as if you clicked the Record button. If Multitrack Record is 
selected in HyperScribe’s Record Mode submenu, you must set up the Instrument List to spec-
ify the recording information (which staves or layers to record into, and which channels to 
receive from).

• Fast Forward 2222. This button makes the number in the Measure text box advance rapidly. If 
the music is already playing back and you want to skip ahead, click this button for a moment, 
then release; playback will resume from the measure number (that you just changed) in the 
Measure text box.

• Fast Forward to End ..... When you click this button, the Measure text box shows the number 
of the last measure in the score.

If the music is already playing back when you click this button, Finale will stop playback for a 
moment, play the last measure of the score, and stop.

• Measure__. This text box has two functions. Before you begin playback, it indicates the first 
measure to be played. And while playback is underway, it changes to show you the measure 
being played.

• Playback Settings . Most of the time, the controls described above are adequate for con-
trolling playback. If you want to use some of Finale’s more powerful options, click the Play-
back Settings button. The Playback Settings dialog box opens to reveal several other controls 
and options. See PLAYBACK SETTINGS DIALOG BOX. 

• Tempo: Whole Note • Half Note • Quarter Note • [etc.]. The Playback Tempo is used for playback 
only. The tempo used for recording is set in the Playback and/or Click dialog box. The Playback 
tempo controls let you establish the playback tempo for your piece. Of course, if you’ve set up the 
tempo in other ways—by recording tempo changes played into the Transcription Mode of Hyper-
Scribe, for example, or by placing tempo markings into the score—then this tempo setting will have 
no effect. See PLAYBACK AND/OR CLICK DIALOG BOX.

Not every tempo is measured in quarter notes per minute, of course, so you can select the 
basic unit of the tempo pulse (Half Note, Dotted Quarter Note, and so on) from the Tempo 
drop-down list. To set the number of beats per minute—the actual tempo—either type a new 
number into the text box, or click the arrows to increase or decrease the displayed number.

Playback Settings dialog box
How to get there

From the Windows Menu, choose Playback Controls. Click on the Playback Settings  button 
on the Playback Controls.

What it does
In this dialog box, you can define Finale’s handling of a number of playback variables, for real-
time playback and playback files.
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• Play Mode: Non-Scrolling • Non-Scrolling (Pre-Scan Music) • Scrolling. Choose Non-
Scrolling to play back your music without showing a pointer on the music as it plays back. 
Choose Non-Scrolling (Pre-Scan Music) if you want Finale to pre-process the music before it 
plays back; no pointer is shown when the music plays back. Choose Scrolling if you want 
Finale to show a pointer as the music plays back. Finale will automatically pre-scan the music 
before playing; when the pointer reaches the edge of the window, Finale advances to the next 
screen of music.

• Swing: Swing Values. This control allows you to apply a swing feel to the entire piece. If 
you’ve created an Expression with a Swing effect, the expression will override this control. 
Click on the Swing Values drop-down menu to select from several levels of swing or type the 
percentage of swing in the text box (0% = no swing, 100% = standard swing). For more 
details, see SWING PLAYBACK.
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• Base Key Velocity. This number, on a scale from 0 (silent) to 127 (very loud), establishes the 
overall key velocity setting for the playback of your piece. (Key velocity is usually equated 
with volume, but not always. Finale calculates the effect of dynamic markings (expressions) 
based on this number. In other words, you can make the piece generally softer by decreasing 
this number (but individual dynamics within the piece will still override the playback control 
settings).

• Always Start at: Measure ___ • Leftmost Measure • Current Counter Setting. Using these 
options, specify where you want Finale to begin playback; the default settings tell Finale to 
play from Measure__. Enter a number into the text box (or click the arrows to change the 
number). Alternatively, you can select the Leftmost Measure displayed on the screen or the 
current measure displayed in the counter setting box of the Playback Controls.

Using the Start and Stop options, you can even tell Finale to play measures that aren’t on the 
screen. Or, by entering a small range and repeatedly clicking the Play button, you can, in 
effect, “loop” through a certain segment.

• Stop at: End of Piece • Measure ___. These controls let you specify where playback should 
stop. The default setting tells Finale to play to the end of the piece, but you can enter a number 
into the Measure text box—or click the arrows—to specify a certain stopping point.

• Playback Source: Play Active Document • Play from Playback File. There are two kinds of 
files Finale can play. You’re already familiar with a Finale document—the notated, sheet-
music kind of document you work on most of the time. The active document is the one in the 
frontmost window (if you have several documents open at once), whose name is identified by 
a check mark in the Window Menu.

A playback file is a special audio-only file which can be saved onto your disk independently of 
the notation document. When Finale creates a playback file, it’s already done all of the work 
involved in “sightreading” your score. Therefore, when you play back a playback file, you’re 
less likely to overwhelm the computer with the task of creating MIDI playback—a useful fact 
to remember if you’re working on a fast or “notey” score which seems to be bogging down the 
computer.

The second important advantage of a playback file is that it permits the computer to focus its 
processing power on the task of scrolling the screen display to keep up with the audio play-
back. Only when it’s using a playback file (or pre-scanning the music) can Finale scroll the 
music on the screen for you.

If you’ve created playback files by clicking the Save File button, you can load them into 
Finale’s memory, ready to play, by clicking on Select File in the Playback File area. A list box 
will appear, showing the contents of the current folder on your hard disk; find the playback file 
you want to play and double-click it. Then make sure Play from Playback file is selected in 
Playback Source. Click Play on the Playback Controls to hear it played back.

• Click and Countoff. Click this button to display the Click and Countoff dialog box, where 
you can set what will be played for a metronome click, whether a countoff will play and for 
how long, and when a metronome click will be heard. For information about setting the 
options for click and countoff in your music, see CLICK AND COUNTOFF DIALOG BOX.

• Playback Options. Click this button to display the Playback Options dialog box where you 
can specify how Finale plays back your score. See PLAYBACK OPTIONS DIALOG BOX.
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• Playback File: Save File • Select File • Current Selected File. Click the Save File button to 
create either a MIDI file or a Playback File of the measures indicated in the Play From and 
Play Through boxes. You’ll be asked to provide a title, and you can save it into any folder on 
your hard disk. When you want to play it later, choose Play from Playback File from the Play-
back source area, then click on Select File in the Playback File area. When your file is 
selected, it will appear under Current Selected File.

• OK • Cancel. Click Cancel to return to your score without making any changes to the dialog 
box. Click OK (or press enter) to confirm your playback settings and return to the score.

Click and Countoff dialog box
How to get there
Choose Click and Countoff from the Options Menu.

Or, choose Playback Controls from the Window Menu to display Playback Controls (a checkmark 
appears by the command when displayed). Click on the Playback Settings button, then click the 
Click and Countoff button.

Or, click the HyperScribe Tool. Choose Playback and/or Click from the Beat Source submenu of 
the HyperScribe Menu. Click the Click and Countoff Button.

What it does
Use the Click and Countoff dialog box to define the countoff click settings and the metronome 
click used for HyperScribe recording, and for playback using Playback Controls. Set up the num-
ber of measures you want Finale to count off before starting to record. Choose when you want to 
hear a metronome click, and what the clicks should sound like. Increased control over the click 
sound includes the ability to emphasize the down beat, for example, by increasing the key velocity 
of the click or by lowering the pitch of the “other beats” in the measures. When you change the 
number of countoff measures in this dialog box, Finale automatically updates the number of 
countoff measures in Playback Controls as well. If you have selected Tap as your Beat Source, 
Finale will ignore the settings in this dialog box.
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• Countoff: Always • While Recording • While Playing • Never. Use the drop-down list to 
specify when you want Finale to play a countoff metronome click. Choose Always if you want 
a countoff of a specified number of measures before recording with HyperScribe or playing 
back with Playback Controls. Choose While Recording if you want the countoff only when 
you’re recording with HyperScribe. Choose While Playing if you want a countoff only when 
you’re playing back with Playback Controls, or choose Never if you don’t want any countoff 
at all. These global settings are saved with your preferences.

• Measures__. Enter the number of measures you want Finale to count off before starting to 
record with HyperScribe or play back using Playback Controls. Enter 0 (zero) if you don’t 
want a countoff, 1 if you want one measure counted off, 2 to hear two measures, and so on. 
Finale uses the meter of the first measure selected for playback or for recording into to deter-
mine the meter of the countoff measure. Any change you make to the countoff is automatically 
updated in the Countoff text box in Playback Controls.

Note: Finale will always sound a metronome click while playing the countoff measures.

• Click: Always • While Recording • While Playing • Never. Use this drop-down list to deter-
mine when Finale should play a metronome click to indicate the beat in your music. Choose 
Always if you want to hear a metronome click while recording with HyperScribe and playing 
back with Playback Controls. Choose While Recording if you want a metronome click only 
when recording with HyperScribe. Choose While Playing if you want a metronome click only 
when playing back with Playback Controls, or choose Never if you don’t want any metronome 
click to sound while recording or playing back.

• Source: MIDI Note • MIDI Data. Use this drop-down list to specify the type of MIDI signal 
for the down beat and the other beats in the measure. In general, you’ll probably choose a 
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MIDI note rather than a MIDI event for the metronome sound. You can choose any MIDI note 
for the metronome click, but to distinguish the down beat click from that of other beats, you 
might want to choose a short percussive sound or a high note. Choose MIDI Data if you want 
to use something other than a MIDI Note for the metronome click.

• Metronome Sound: Down Beats • Other Beats; Channel • Note • Velocity • Duration (% 
of the beat); Listen. The labels in the text boxes change if you choose MIDI Data; you’ll see 
Channel, Status, Data1, Data2, and Duration, instead of Channel, Note, Velocity, and Dura-
tion. To have Finale enter this information automatically for you, click Listen in the Down 
Beats or Other Beats row, then play the note or trigger the MIDI event that you’re planning to 
use for the metronome click. Finale will automatically enter all values except Duration for 
you; if you prefer, you can type these values yourself.

To enter MIDI Note information manually (MIDI Note is selected in the Source drop-down 
list), enter the MIDI channel number and the MIDI note number into the corresponding text 
boxes. Specify how hard the note should be struck by entering a value between 0—127 (0 
being the softest, 127 the loudest) in the Velocity text boxes. Change the Duration value if you 
want to change the length of the metronome click sound. Enter the note length in terms of the 
percentage of the beat. For example, if a quarter note is a beat and you want the click to be 1/2 
the length of the beat (in other words, an eighth note), type 50 (for 50%) into the Duration text 
box. When MIDI Data is selected in the Source drop-down list, enter the MIDI channel num-
ber for the click, then enter the MIDI status into Status and data byte values into Data1 and 
Data2. Your MIDI device’s manual should contain the values that you need to enter, depending 
on the effect you want to achieve.

• OK • Cancel. Click Cancel to return to your score without making any changes to the dialog 
box. Click OK (or press enter) to confirm your click and countoff settings and return to the 
score.

Click and Countoff
Use the settings in the Click and Countoff dialog box to define the metronome click played when 
you’re recording with HyperScribe or playing back using Playback Controls. Specify the number 
of measures, if any, you want counted off prior to recording. Set when you want to hear a metro-
nome click, whether a MIDI note or a MIDI event will be played for the click, its exact sound, 
how hard the note should be “struck”, its duration, and whether Finale should wait for a start sig-
nal before starting countoff and recording. If you have selected Tap as your Beat Source Finale 
will ignore the settings in this dialog box.

For more information about click and countoff settings, see CLICK AND COUNTOFF DIALOG BOX.

To set up countoff measures and the metronome click (for Playback and 
HyperScribe recording)
• From the Options Menu, choose Click and Countoff to display the Click and Countoff 

dialog box.
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• Choose an option from the Countoff drop-down list to set when Finale will provide a 
countoff of measures before starting to record or play back. Choose Never if you never 
want a countoff; choose Always if you always want a countoff when you’re playing back and 
recording; choose While Playing or While Recording if you want a countoff only while play-
ing back or only while recording, respectively. Finale will always sound a click when playing 
countoff measures.

• In the Measures text box, enter the number of measures that you want Finale to count 
off before recording or playing back music. Enter zero if you don’t want any countoff, 1 if 
you want one measure counted off, 2 to hear two measures, and so on. If you’re only playing 
back, Finale uses the time signature of the first measure that you’re playing back to determine 
the time signature of the countoff measure. If you’re recording, Finale uses the beat duration 
set in HyperScribe’s Quantization dialog box.

• Choose an option from the Click drop-down list to determine when the metronome click 
will play. Choose Never if you never want a click; choose Always if you always want a click 
when you’re playing back and recording; choose While Playing or While Recording if you 
want a click only while playing back or only while recording, respectively. Regardless of this 
setting, Finale will always play a metronome click during countoff measures.

• Choose MIDI Note or MIDI Data from the Source drop-down list, depending on whether 
you want a MIDI note or MIDI event as the clicks. You can specify different MIDI signals 
for the down beats and other beats. To have Finale automatically fill in the MIDI settings for 
you, click Listen, then play the MIDI note or activate the MIDI event; Finale will fill in all the 
settings for you, except for Duration. If you prefer, type the MIDI information into the text 
boxes. For details, see CLICK AND COUNTOFF DIALOG BOX.

• Click OK to return to the score. When you record, Finale will use the settings you just 
made.

To setup a click with a non-percussion playback device
• From the MIDI Menu, choose MIDI Thru. The MIDI Thru dialog box appears.
• Click Smart and click OK.
• From the MIDI Menu, choose MIDI Setup. The MIDI Setup dialog box appears.
• Click the Advanced button. The MIDI Setup dialog box expands.
• In the first MIDI IN slot (above Hide Advanced Settings), select the driver for your MIDI 

IN device (usually with MPU or MIDI IN in its name.)
• In the first MIDI OUT slot (above Hide Advanced Settings), select the driver for your 

MIDI OUT device (usually with MPU or MIDI OUT in its name.)
• For the second MIDI OUT slot (below Hide Advanced Settings), select the driver for 

your computer speakers (usually with the words Synth or FM in its name.)
• Set the base channel to 17. Click OK.

• Click the HyperScribe Tool g. The HyperScribe Menu appears.

• From the HyperScribe Menu, choose Beat Source, then Playback and/or Click.
• Click on the Click and Countoff button. The Click and Countoff dialog box appears. See To 

setup countoff measures and the metronome click (for Playback and HyperScribe Recording) 
above for more details.
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• Enter 26 in the Channel box for both Down Beats and Other Beats. Leave the other boxes 
in their default values. See GENERAL MIDI PERCUSSION MAP TABLE for more information.

Playback Options dialog box
How to get there
From the Options Menu, choose Playback Options. Or, choose Playback Controls from the Win-
dow Menu. Click the Playback Settings button; then click Playback Options.

What it does
In this dialog box, you can define Finale’s handling of a number of playback variables, for real-
time playback and playback files. For example, you can specify whether or not it should scan the 
music and “chase” expression markings that occur before the measure you click (if you’re starting 
playback in mid-piece); and whether or not Finale should use the tempo, pedaling, and velocity 
information from your original real-time performance (if your piece is a transcription created with 
the HyperScribe Tool).
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• Play Recorded Key Velocities • Play Recorded Note Durations • Play Recorded Continu-
ous Data • Play Recorded Tempo Changes. There are four kinds of playback data Finale 
stores invisibly with the notes in your score. Key Velocity data describes how hard each note 
was struck, which usually determines how loudly it plays back. Note Durations means Start 
and Stop Time data, the small rhythmic deviations from the beat that give a performance a cer-
tain rhythmic feel; swing, rolled chords, and rushing the beat are all products of Note Duration 
data. Continuous data is data generated by the pitch wheel, patch changes, and controllers 
such as the pedal. And tempo changes, in this case, are tempo changes you created using the 
Transcription Mode of HyperScribe and adding Time Tags; see TRANSCRIBING A SEQUENCE.



Playback Options dialog box 39-11      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

All of this MIDI information is generated when you record a live performance using Hyper-
Scribe. To capture this information in the Transcription Mode, select the two corresponding 
checkboxes in the lower-left corner of the Transcription window before transcribing your per-
formance. To record key velocity and Note Duration information using HyperScribe, choose 
Quantization Settings from the Options Menu, then More Quantization Settings before record-
ing, and check Record Key Velocities and Record Note Durations. (HyperScribe doesn’t 
record continuous data or tempo changes.)

You can also create this data directly in the score using the MIDI Tool (except for tempo 
changes, which you can create with the Tempo Tool). Of course, you can place articulation or 
expression markings into the score that produce similar playback effects.

If you select all four checkboxes, then, you’ll hear a playback that precisely duplicates your 
original performance—complete with pedaling, subtle dynamics, ritards and accelerandi, and 
uneven rhythms—even if the resulting notated version looks considerably different. If you 
don’t select any of these checkboxes, Finale will sightread your notated score exactly as it 
appears on the screen—which will be a rhythmically square, expressionless playback with no 
dynamics and no tempo fluctuations.

• Ignore Repeats. Select this checkbox if you want Finale to play through your piece, ignoring 
any repeat barlines or text repeats as though they didn’t exist.

• Reset Repeats. Select this checkbox if you want Finale to treat any repeat barlines (or text 
repeats) it encounters as though it’s reaching them for the first time. If you don’t specify Reset 
Repeats, Finale will remember how many times it’s encountered each repeat sign each time 
you stop playback, and—when you start again—it will continue playing your piece as though 
you’d never stopped. If you’re proofreading a score by playing a section at a time, you proba-
bly won’t want to select this option; Finale will “remember its place” as you play each section.

• Playback Files. All options in the Playback Files group box are only used when a playback 
file is selected for playback. (If you’re playing the Active File, Pre-Scan Music must be 
selected in Playback Settings.)

• Wait for MIDI Sync. If your computer is connected to an external drum machine or other 
sequencer, and you want Finale to be the “slave” device for synchronization purposes, select 
this box (If you’re playing the Active File, Pre-Scan Music must be selected in Playback Set-
tings.) Finale won’t begin playback until it receives a MIDI Sync signal from the external 
device. Note that when Wait for MIDI Sync is selected, the start measure displayed in Play-
back Controls is considered to be measure 1. For example, if the Playback Controls’ start mea-
sure is measure 10, and the master sends sync information to go to measure 5, Finale will 
advance 5 measures to measure 15.

• Send Patch Changes During MIDI Sync • Send Continuous Data During MIDI Sync. 
These technical options are only available if you’ve selected Wait for MIDI Sync (and your 
computer is connected to an external sequencer).
In the event that the external sequencer is playing a sequence of its own, there’s a danger that 
your synthesizer will be confused by duplicate MIDI data being generated by Finale and the 
sequencer. Using these options, you can specify what kinds of MIDI data you want Finale to 
transmit, so that you can avoid simultaneous transmissions of the same kinds of data to the 
same synthesizer. Choose Send Patch Changes During MIDI Sync if you want Finale to 
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transmit any patch changes you’ve created in your score as it plays back. Choose Send Con-
tinuous Data During MIDI Sync if you want Finale to transmit continuous data (use of the 
pedals, pitch or modulation wheels, aftertouch, and so on). 

• Use MIDI Configuration from: Playback File • Active Document. Suppose you create a 
playback file of a document and save it onto your disk (see PLAYBACK SETTINGS for a descrip-
tion of playback files). Now you open a different document, but specify that you want to hear 
the playback file played back.
In that instance, Finale has two possible sets of MIDI setup information (MIDI channel 
assignments, patch selections, Instrument List configuration) from which to choose—that of 
the open Finale document, or that of the playback file you’ve selected. Use this drop-down list 
to specify which MIDI parameters you want to use.

• Dynamics and Markings: Reset • Use Current Settings • Chase from First Measure. If 
you choose Chase from First Measure from this drop-down list, Finale will take a moment 
to read through, or “chase,” any expressions, and patch changes that occur between the begin-
ning of your piece and the first measure you’ve selected to play back. In so doing, Finale can 
take into account changes in tempo, volume, and patch settings that occurred earlier in the 
piece so that all MIDI variables will be at the correct current settings. (The “chasing” process 
may take awhile before playback begins, depending on how far you are from the beginning of 
the piece.)

Choose Reset, on the other hand, if you don’t want Finale to “chase” those tempo, volume, 
and other markings from the first measure before beginning playback in the middle of a piece. 
(Instead, Finale will begin playback using the Tempo and Base Key Velocity you’ve indicated 
in the Playback Controls and the Playback Settings, until it encounters any other expression 
markings while playing back.)
But if you plan to play your piece a section at a time, you may want Finale to simply remem-
ber the tempo, volume, and controller settings at the end of each passage you play, so that it 
will be ready to continue with the next measure. If you select Use Current Settings, Finale 
doesn’t have to “chase” these expressions from the beginning of the piece each time you con-
tinue playback; it remembers them.

• Duration of Grace Notes _ EDUs • Set Duration. Enter a value in the EDUs text box to 
specify the grace note duration (there are 1024 EDUs in one quarter note), or click Set Dura-
tion. If you choose Set Duration, the Set Duration dialog box appears and you can choose a 
duration value from the note palette. Finale will automatically enter the corresponding EDU 
value in the text box. Grace notes on any given note will play back according to the duration 
that you specify.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog 
box. Finale will use the option settings you’ve just made whenever it plays back your score or 
creates a playback file. Click Cancel to leave the dialog box without changing any settings.

Playback
Finale can play your score back over any MIDI channel configuration you can devise. See MIDI 
CHANNELS to find out how to assign each staff to a MIDI channel.
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When Finale plays back, it responds to any musical markings you’ve placed in the score, such as 
staccato or accent marks, dynamics, and MIDI patch and channel indications. For details on creat-
ing playback-intelligent symbols, see ARTICULATIONS, EXPRESSIONS.

It’s important to understand that Finale can play your score in one of two ways: either literally 
(simply reading the notes and dynamics exactly as they appear on the printout) or with expression 
(incorporating fluctuations in volume, timing, or tempo). Finale captures this expressive data 
whenever you record a live performance with the Transcription Mode (or when you import a 
MIDI sequencer file): key velocity data (how hard you struck the keys), MIDI continuous data 
information (your use of the sustain pedal, the pitch wheel, and other controllers and wheels), and 
tempo fluctuations. If you “capture” this data before transcribing the performance into notated 
form, Finale will retain it even after the performance has been turned into notation, and can play it 
back—nuance for nuance—at any time. If you prefer, however, you can listen instead to the 
“sheet-music” version of your score, as Finale simply reads the quantized, notated version of the 
piece, without any variations in tempo or expression.

 If you plan to transcribe your real-time performances or use Finale as a notation-based 
“sequencer,” then it’s important to understand this distinction between a playback of the score and 
a playback using the captured MIDI data. A number of Finale functions apply to one or the other 
kind of playback only; the MIDI Tool is a good example. Many of its options are specifically 
intended for the editing of the captured MIDI data, just as you would edit the raw MIDI data of a 
performance in a sequencing program.

Finally, remember that the notated score and the captured MIDI data aren’t completely indepen-
dent. Suppose you transcribe a performance with the Transcription Mode and capture the MIDI 
data. When you play the piece using the captured MIDI data, you’ll hear it played with your orig-
inal “feel”—volume, tempo, pedaling, and so on. Yet you can edit the transcription by changing 
notes, transposing, adding dynamics or other playback expressions—and you’ll hear the edited 
music play back with the captured MIDI data still intact.

For instructions on capturing performance data, see TRANSCRIBING A SEQUENCE and MIDI FILES–
To import a MIDI file.

To play back a score
• While pressing the Space bar, click the measure at which you want to begin playback. 

See the table below for various options in starting playback. It doesn’t matter which tool is 
currently selected. The behavior of the playback is governed by the settings in the Playback 
Options dialog box (see “To specify playback parameters” below). 

Command Keyboard Shortcut

Begin playing from the current measure Spacebar–click in staff

Begin playing from current measure in the current staff only Shift-spacebar–click in staff

Begin playing from current measure in the global staff list Spacebar–click in between staves

Begin playing from measure one in the global staff list Spacebar–click to the left of a staff system

Begin playing from measure one in the current staff only Spacebar-click to the left of a staff

“Scrub” onscreen music - all staves Ctrl-spacebar (and drag across music)

“Scrub” onscreen music - current staff only Ctrl-Shift-spacebar (and drag across music)
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• Click on the screen to stop the playback. Finale may take a moment to respond.

To use Playback Controls
Playback Controls reside on a movable window. They give you several additional controls over 
the way your score plays back—for example, they contain Play, Stop, Rewind, and Fast Forward 
buttons. They also let you listen to any portion of the score, even if you’re viewing a different sec-
tion on the screen.

• From the Window Menu, choose Playback Controls. Playback Controls appears. 

• Adjust the Measure control, if necessary. This text box shows the first measure to be played. 
To change this number, either type in a new one, click the up or down arrows, or click one of 

the large buttons on Playback Controls. The  button (Rewind to Beginning) enters 1 in the 

Measure text box. The  and  buttons quickly decrease or increase the number in the 

Measure text box, and the  button (Fast Forward to End) puts the last measure’s number in 
the text box.

• Click Play. The music plays. To Stop, click Stop; to pause click Pause; when you’re ready to 
go on, click Pause again.

If, while you’re listening, you catch something you’d like to hear again, click the  button 
for a few seconds; Finale will suspend playback, the Measure text box number will decrease 

(as the program “rewinds”). Release the  button, and playback will begin again (with the 

number in the Measure text box). Similarly, you can click the , , and  (Rewind to 
Beginning) buttons at any time during playback.

• For additional playback options, click the Playback Settings button The Playback Settings 
dialog box opens.

Using Always start at and Stop at, specify what range of measures you want Finale to play; 
the default settings tell Finale to play from Measure 1 displayed on the screen through the end 
of the piece. By changing these numbers, you can even tell Finale to play measures that aren’t 

Click to 
jump to
measure
one. 

Click to jump
backward in 
the score.

Click to stop
playback.

Click to start playback

Click to begin a 
HyperScribe

This number indicates
the first measure you’ll 
hear played

Click to open
Playback Settings
(for more options).

Click to jump to the
last measure in the
score.

Click to jump
forward in

session at the 
current measure

Click to pause
playback

Click to select
what gets the beat
in the tempo

 the score.

Click to enter
a playback tempo
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on the screen. Or, by entering a small range and repeatedly clicking the Play button, you 
could, in effect, “loop” through a certain segment.
If the Scrolling is selected, Finale takes a moment to pre-process the music it’s supposed to 
play. See “To correct erratic MIDI playback” and “To make the music scroll during playback,” 
below.
The Tempo control sets the playback tempo unless you’ve created tempo changes by record-
ing them, by placing Expression marks, or by using the Tempo Tool. The Base Key Velocity, 
on a scale from 0 (silent) to 127 (very loud), establishes the overall key velocity setting, from 
which all dynamics are measured. In other words, you can make the piece generally softer by 
decreasing this number, but individual dynamics within the piece will still have an effect.
The remaining controls in Playback Settings window let you manage files. Click Save File to 
create either a MIDI file or a Playback File of the measures indicated in the Start at and Stop at 
boxes. See MIDI FILES and “To make the music scroll during playback,” below. For a more 
detailed discussion of Playback Controls, see PLAYBACK CONTROLS.

To play back selected staves
• From the Window Menu, choose Instrument List. The Instrument List appears.

• Click in the Play column so that the filled square turns white (for each staff you want to 
silence), or click in the Solo column (to silence all other staves). In other words, if your 
score has 40 staves, and you just want to hear the piano part, it’s much quicker to click Solo 
for the two piano staves than to turn off Play for the other 38 staves. But if you want to hear 
everything but the piano, click in the Play column for the piano staves so that the filled squares 
turn white.

Click again to reverse the status of a staff (click a white Play square to make it filled again, or 
click a Solo circle to turn it off).

To send an All Notes Off message
On rare occasions, you may encounter a situation called MIDI lock, in which your synthesizer is 
“stuck” on a certain note or chord.

• From the MIDI Menu, choose All Notes Off. Finale sends an “all notes off” message to 
every note of every channel. You should find that, after a moment, the situation is corrected.

To correct erratic MIDI playback
If your score is very “notey,” you may find that your computer occasionally gets overwhelmed by 
the amount of MIDI data it’s asked to play; the result is a stuttering playback or a complete halt. In 
these cases, select Non-scrolling (Pre-Scan) from the Play Mode: drop-down list in the Playback 
Settings; Finale will take an extra moment before beginning playback to pre-process the music, 
taking some of the workload off the computer.

As an alternative, create a Playback File of the selected music by clicking Save File in the Play-
back Settings dialog box. Then click Select File, open the new Playback File, and choose the file’s 
name. Click on Play from Playback File in the Playback Source area. Finale will now play back 
the Playback File instead of what’s displayed on the screen. (See TROUBLESHOOTING for more 
MIDI Troubleshooting tips.)

Finally, if your score has many chords, consider using the MIDI Tool’s Randomize command to 
offset the notes’ attacks (Start Times) slightly from each other—not enough to hear, but enough so 
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that your MIDI system doesn’t have to handle many notes being struck precisely together. See 
MIDI TOOL MENU.

To specify playback parameters
When you play back your score, Finale checks the Playback Options to find out certain playback 
parameters, as described here.

• From the Options Menu, choose Playback Options. The Playback Options dialog box 
appears.

• Select the playback parameters you prefer from the Playback Options dialog box. 
Choose Chase from First Measure (from the Dynamics and Markings drop-down list) if you 
want Finale to quickly scan your piece and “chase” any expression markings that occurred 
earlier in the piece up to the point you clicked. These might include tempo, dynamics, patch 
changes, and so on; select this option if you’re starting playback in the middle of the piece and 
want these playback variables to be current (and transmitted to your synthesizer) as of the 
starting point you clicked. If you choose Reset instead, Finale will ignore any changes that 
have occurred prior to this point in the score, and will begin playing based on the markings 
available in the measure you clicked. Choose Use Current Settings if you’ve interrupted 
playback at a certain spot, and now want to continue using the expression settings in effect 
when you stopped playback.

Click Ignore Repeats if you want Finale to play through repeat barlines (and text repeats) as 
though they didn’t exist. Select Reset Repeats if you want such repeats to be “set to zero” 
each time you begin playback again. If you don’t specify Reset Repeats, Finale will remember 
how many times each repeat has been “activated.” If you’re proofreading a score by playing 
one section at a time, you will want Finale to “remember its place” each time you stop, so you 
probably won’t want to select this option.

Next, specify any captured MIDI data you want to incorporate into the playback. Captured 
MIDI data is captured from a real-time performance in the Transcription Mode, created with 
the MIDI Tool, or imported in a standard MIDI file from another sequencer. Select Play 
Recorded Key Velocities and Play Recorded Note Durations if you want the playback to 
incorporate the key velocity (volume) information and Start and Stop Time data (tiny anticipa-
tions or delays of the beat such as rolled chords and swing) from the original performance. 
Select Play Recorded Continuous Data if you want the playback to use the pedaling, pitch 
wheel, and other MIDI continuous data information from the original performance.

Click Send Patches Before Play from the Instrument List window if you want Finale to send 
initial patch settings to your synthesizers before beginning the playback. The initial patch set-
tings are determined by the Instrument List (see PATCHES).

• Click OK (or press enter). 

To make the music scroll during playback
When you play back music in the usual way, the screen display doesn’t change. If you want, you 
can tell Finale to scroll the music, so you can follow the score as you’re listening to the playback.

• From the Window Menu, choose Playback Controls. Playback Controls appears.

• Click the Playback Settings button. The Playback Settings dialog box appears, offering 
additional controls.
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• Select Scrolling from the Play Mode drop-down list. You may now play the music in the 
normal way; Finale will take a moment to process the musical information before playback, so 
that the computer can devote its energy to processing the visual display during playback. (You 
can also use the Scrolling option in conjunction with a Playback File; see “To play from a 
playback file,” below.)

To play from a playback file
A Playback File is also useful for avoiding “MIDI logjam,” where too many notes are being pro-
cessed by the computer at one time, and for scrolling playback.

• From the Window Menu, choose Playback Controls. Playback Controls appears.

• Click the Playback Settings button. The Playback Settings dialog box appears, offering 
additional controls. Specify the measure range you want to include in the Playback File, and 
click Playback Options to make your playback settings.

• Click Save File. Name your Playback File and press enter. The Playback File is saved on 
your disk.

• To play from the Playback File: choose File, then Play from Playback File.Select Play-
back If you wish, you can turn on scrolling playback—see “To make the music scroll during 
playback.” Now play the score in the usual way. For extra flexibility, Finale doesn’t insist that 
the file on the screen match the Playback File; it’s perfectly possible to watch one score scroll 
by while listening to another.

 To “audio spot-check” music
No particular tool has to be selected.

• While pressing ctrl and the Space bar, drag the cursor across your score. As the cursor 
strikes each note, you hear it played on your MIDI keyboard. You can drag in any direction, 
and at any speed, and from one staff to another. You might use this trick for checking chord 
voicings, scanning small sections for wrong notes, or just for fun.See KEYBOARD SHORTCUTS 
- PLAYBACK for more information.

Swing Playback
To create swing playback (for the entire piece)
Note: This method is for generating swing feel from an otherwise “straight” score. (If you’ve used 
HyperScribe to record a performance, you can “capture” the swing feel. Make sure Retain Note 
Durations is checked in More Quantization Settings and Play Recorded Note Durations is checked 
in Playback Options (see OPTIONS MENU). When you playback, you’ll hear the music with your 
original feel, including swing, played back.)
• From the Window Menu, choose Playback Controls. Playback Controls appears.

• Click the Playback Settings button. The Playback Settings dialog box appears, offering 
additional controls.

• From the Swing drop-down list, choose Standard.

• Click on Play.
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To create swing playback (for sections of the piece) Expression Tool method

• Click the Expression Tool y. If you haven’t yet placed the marking in the score, double-

click any note or measure. When the Expression Selection dialog box appears, click the 
desired marking, click Edit, and then skip to the instruction marked by the asterisk (*).

• Click the measure or note to which the tempo marking was attached. Its handle appears.

• Double-click the handle. The Text Expression Designer dialog box appears.

* Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Swing; then enter a number in the Set to Value 
box or select a choice from the Swing drop-down list. The number you type into the box 
indicates a percentage of swing. The larger the percentage of swing, the more delay before the 
second note.

• Click OK (or press enter). Any time Finale encounters the expression you’ve just defined 
when it plays back your score, the playback will change to reflect the expression’s swing defi-
nition.

To create swing playback (for sections of the piece) MIDI Tool method

• Click the MIDI Tool p. Select the region where you want the playback to have a 

swing feel. You can select one measure by clicking, additional measures by shift-clicking, a 
screenful by drag-enclosing, an entire staff by clicking to the left of it, or the entire piece by 
choosing Select All from the Edit Menu.

• From the MIDI Tool Menu, choose Note Durations. 

• From the MIDI Tool Menu, choose Alter Feel. Type 171 into the Backbeats By” text box. 
If you enter a number larger than 171, your swing effect approaches a dotted-eighth/sixteenth 
feel, which is useful in slower swing tempos; if you enter a number smaller than 171, the 
swing effect approaches an even-eighth-note feel, which might be better at faster tempos.

• Click OK (or press enter). When you play back the selected region, you’ll hear genuine 
swing—Finale is playing the second eighth note of every eighth-note pair slightly late, just as 
a jazz player would.

Note: These instructions assume that the time signature is , , or ; the “backbeats” that 

Finale delays are, therefore, every other eighth note. If the meter is , however, the backbeats 

are every quarter note, so the swing playback you get may seem erratic if you were expecting 
traditional eighth-note swing. To solve the problem, change the time signature to a quarter-
note–based one before using the MIDI Tool.

Note: Do not use both MIDI Tool Swing and Swing from the Playback Controls, as these 
effects are additive.

2

4
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Tempo (for playback)
This entry includes information on setting actual tempos for playback. To create metronome 
marking tempo indications (q=120), see METRONOME MARKINGS. See also TEMPO MARKINGS.

For information regarding tempo fluctuations while recording or transcribing a real-time perfor-
mance in the Transcription Mode of HyperScribe, see also PLAYBACK and TRANSCRIBING A 
SEQUENCE.

To set the initial playback tempo
The tempo you set with this procedure is the default starting tempo Finale uses when it plays back 
your score by “reading” the notated, quantized music. If your score is a transcription of a perfor-
mance you recorded with the Transcription Mode, however, you also have the option of hearing a 
playback with the actual tempo of the original performance, including any fluctuations. For a 
complete discussion of this process (capturing MIDI data), see To specify playback parameters.

• From the Window Menu, choose Playback Controls. Playback Controls appears.

•  Enter the starting tempo in the Tempo text box. The number you type here is the standard 
metronome setting (beats per minute). Use the drop-down list to set the note value—quarter 
note, for example.

To modify the playback tempo
At any point in the score, you can insert a functional tempo marking (such as Presto or Adagio) 
that will actually change the tempo during playback (see TEMPO MARKINGS). For gradual tempo 
changes, see also ACCELERANDO and RALLENTANDO.

Instrument List window
How to get there
Choose Instrument List from the Window Menu.

What it does
The Instrument List provides a quick and convenient way to manage the playback of the various 
staves in your score. For example, you can silence a staff with a single click, or you can “solo” a 
staff with a click, muting all other staves.

If your MIDI instrument is multitimbral—capable of playing more than one instrument sound at 
once—the Instrument List also lets you assign a MIDI channel and patch (program information 
and optional bank change information which act together to provide an instrument sound) to each 
staff—and, in fact, to each layer of each staff. 

The Instrument List also lets you create Instrument assignments for each staff and each layer of a 
staff. An Instrument is a MIDI channel/patch setting. For example, you might create an Instrument 
named Strings which will be mapped to your MIDI keyboard’s channel three, and will have the 
patch set to change your keyboard to its second bank of sounds and use the Strings program on 
that bank. 

Then, it’s a simple matter to assign each of the string staves in your score to this same Instrument, 
saving you the trouble of assigning a channel and patch to each staff individually. Instead of map-
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ping multiple staves into one Instrument, you can also do the reverse—map a single staff into mul-
tiple Instruments—by setting a staff’s layers to play on different MIDI channels with different 
patches.

The Instrument List window also affects recording with HyperScribe. Two columns in the Instru-
ment List, R and RChan (R always appears; RChan only appears for multitrack recording), iden-
tify which staves or layers of staves Finale will record into, and from which channels, during 
HyperScribe recording. These settings appear only when View by Staves is selected.

The Instrument List, by the way, is a standard Finale floating window. You can move it by drag-
ging the title bar at the top, close it by clicking the control-menu box in the upper-left corner, click 
the Maximize button in the upper-right corner to make it fill your screen, or make it taller or 
shorter by dragging the resizable frame. (You can also hide the Instrument List window by choos-
ing its name a second time from the Window Menu.)

• R. A Record (R) column that specifies which staves or layers will be recorded into, with 
HyperScribe, always appears. When the Record column is blank, no staves (or layers) of 
staves are selected to record into. Click in the R column next to the staff you want Finale to 
record into. A black triangle appears in the R column, indicating that Finale will record into 
the active layer of that staff.
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You can also record into a particular layer of a staff. First expand the staff by clicking the 
down arrow next to the staff name; Layer 1 through Layer 4 appears. If the staff is selected to 
record into (a black triangle appears in the R column for the staff name), a small triangle in 
parentheses indicates the current layer that will be recorded into. If you change the current 
layer using the Layer Controls in the Document window, the small triangle moves to reflect 
the current layer that will be recorded into. To specify a particular layer to record into, click in 
the R column next to the layer of the staff you want Finale to record into. Note that you cannot 
record chords or expressions in an expanded staff; Finale will ignore any clicks in the R col-
umn for chords and expressions. 
If you’re not multitrack recording (Record into One Staff or Split into Two Staves is selected 
in the Record Mode submenu of the HyperScribe Menu), you don’t need to use the Instrument 
List to specify which staff to record into; simply click the staff in the score that you want to 
record into.
If, however, you prefer to use the Playback Control’s Record button (instead of clicking a 
measure in the score), then you must use the Instrument List’s R column to indicate the staff 
or layer to record into. Click in the R column next to the staff or layer you want Finale to 
record into. Click on a different staff or layer to select it instead. The triangle moves to the 
staff or layer you clicked.
If you are multitrack recording (Multitrack Record is selected in the Record Mode submenu of 
the HyperScribe Menu), click in the R column next to the staff or layer you want Finale to 
record into. Click the R column to select additional staves or layers to record into. Click again 
to remove the triangle (so Finale won’t record into the staff or layer).
In an expanded staff list, a triangle in parentheses shows the default layer that Finale will 
record into. If you specify one or more layers of a staff to record into (for multitrack recording 
only), a striped triangle will appear in the R column for the staff name to indicate that one or 
more layers will be recorded into for the staff. The striped triangle also appears in a collapsed 
list so you can immediately see, without expanding the staff, that one or more layers will be 
recorded into.

• RChan. The Record Channel (RChan.) column only appears for multitrack recording (Multi-
track Record is selected in the Record Mode submenu of the HyperScribe Menu). RChan indi-
cates what channel(s) will be recorded into the staves (or layers). Enter the channel number(s) 
that you want Finale to record from for each staff or layer. By default, Finale records from 
channel 1 (RChan is set to 1). If you specify more than one channel for layers of an expanded 
staff, Finale displays the word Mixed in the RChan column for the staff (next to the striped tri-
angle in the R column) to indicate that several incoming channels will record into this staff.

Note: If you’re using multitrack recording, you must set up the Instrument List window’s R 
and RChan columns for each staff (or layer) you want to record into.
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Here’s how you might set up multitrack recording for percussion, by recording information from 
channel 10 into Layer 1 of the Percussion Staff, and information from channel 11 into Layer 2.

Another multitrack recording example, this time for jazz guitar, shows each staff of the Guitar Tab-
lature template assigned to one guitar string, with six different channels, one for each string, record-
ing into each staff.

Note: When you’re not multitrack recording (Record into One Staff or Record into Two Staves 
is selected in the Record Mode submenu of the HyperScribe Menu), the RChan column does 
not appear. In fact, you don’t need to set up the Instrument List window at all; use the Receive 
On channel in the HyperScribe Options dialog box to indicate what channel will be recorded 
for the staff (or layer). Click the measure of the staff you want to record into. (Finale uses the 
Instrument List’s R column to determine which staff to record into only if you click the 
Record button on Playback Controls.)

• Staff Name • [Arrows]. In the Instrument List, you see the staves in your score. (If you 
haven’t named the staves, they appear numbered.) Using the controls in this staff’s row (Play, 
Solo, and so on), you establish its various playback features.

When the small arrow next to the staff name points down, each setting you make affects all 
layers of the staff. If you want to give different playback settings to each of the four transpar-
ent layers of each staff, click the arrow. It turns to point upward, and six new rows appear in 
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the Instrument List, one for each layer, plus one each for Chords and Expressions. At this 
point you can change the Play, Solo, Channel, and other parameters for each individual layer. 
Click the arrow a second time to “collapse” the layer rows into a single staff row again. If 
there are too many rows to see in the window, use the vertical scroll bar to adjust your view.

• Layer 1 • Layer 2 • Layer 3 • Layer 4 • Chord • Expression. These rows of information only 
appear when you click the downward arrow next to a staff name.

Using these subdivisions of a staff, you can assign an Instrument, MIDI channel, or patch to 
each of these playback elements—allowing the music on each layer, for example, to have its 
own sound.

Chords refers to the chord symbol you’ve placed in a staff; they can actually play back over 
their own patch and channel, if you wish. (If you don’t want chord symbols to play back, route 
them to an unused MIDI channel, or deselect chords from the Play column.) You can also 
specify patch and channel settings for the Expressions of a staff. Unless you plan to connect 
the computer to a MIDI-controlled mixing or lighting board—in the event that you’ve created 
expressions that control these external devices—you can leave the expression assignments 
alone.

• P (Play). In this column, a black square appears across from the name of each staff that you 
want to play back when you play your score. By clicking in this column across from a certain 
staff, you make the square disappear, indicating that the staff will be silent when you play the 
score. (The square disappears—meaning “muted”—when you’re soloing another staff; see 
Solo, below.)

If you’ve expanded a staff to view its individual layer assignments, and you turn off the Play 
setting for some layers but not others, the square in the Play column will appear striped. That’s 
your signal that the individual layers of the staff have mixed settings in the Play column. Note 
that the Playback checkbox in the Layer Options provides the same function. See LAYER 
OPTIONS DIALOG BOX.

• S (Solo). When you click in the Solo column across from a staff name, a black circle appears, 
and the black-square Play indicators for all other staves turn white. In other words, you’ve just 
isolated a staff so that only it will play back, and all the other staves are silent. (You could 
achieve the same effect by clicking in the Play column for all other staves, so that their Play 
squares each turn white—but that would take much more time and effort.)

You can solo more than one staff, if you wish—for example, you can solo two or three staves, 
and all the others will be silent. In fact, you can solo all staves, although there wouldn’t be 
much point, since you may as well solo none of them.

• Instrument. By clicking on the word Instrument, you produce a drop-down list containing all 
of created instruments, as well as, the New Instrument command. This command brings up the 
Instrument definition dialog box, where you can define the MIDI channel, program change, 
and bank change assignment for a new virtual Instrument (see INSTRUMENT DEFINITION DIA-

LOG BOX), whose name will now appear in this column.

Once you’ve defined and named one or more Instruments of your own, their names appear in 
the Instrument drop-down list across from each staff name. Now you can start to save time 
when it comes to assigning patches and channels to other staves or layers—simply choose one 
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of your Instrument names from the Instrument drop-down list, and the staff you’re working 
with will automatically get the same MIDI channel, program, and bank settings as other staves 
with that Instrument.

Here’s an example. Suppose you have a piano part with two staves. Across from the top piano 
staff, choose New Instrument from the Instrument drop-down list, and create an Instrument 
called Pno Sound, that plays on MIDI channel 4, program 22. Now, for the bottom piano staff, 
simply choose Pno Sound from the Instrument drop-down list. Finale automatically gives it 
MIDI channel 4, program 22—and if you change the program or channel for either staff, the 
other staff’s program or channel will change to match.

To edit an Instrument name or delete an Instrument, select View by Instruments (see below).

• Chan. This column displays the MIDI channel assignment for each staff (or layer), from 1 to 
64 (or 32, if your MIDI interface is a 32 bit card). To change this number, double-click, and 
type a new channel.

If you’ve assigned several staves to the same Instrument, by the way, remember that they’re all 
linked to the same MIDI channel. Therefore, if you edit the Chan. assignment for any one of 
these staves, the Chan. for all of them will change to match, because any given Instrument can 
only have one channel assignment. (If you truly want a staff to have an independent MIDI 
channel, first assign it to a new Instrument.)

• B. The Bank column (B) appears between the channel and program columns in the Instrument 
List. If you set up a simple patch assignment by entering a program change number with no 
bank information in the Instrument List, nothing appears in the bank column. However, if you 
enter a bank change and a program change number for an instrument, Finale places a “B” in 
the bank column for that instrument.

To set up a bank change, click or ctrl-click the bank column to display the Instrument Defini-
tion dialog box. For details, see INSTRUMENT DEFINITION DIALOG BOX.

• Prog. The number in this column identifies the program (synthesizer sound) number assigned 
to each staff (or layer). To edit it, just double-click the number and type a new one.

If you’ve assigned several staves to the same Instrument, once again remember that they’re all 
linked to the same Program. Therefore, if you edit the Program assignment for any one of 
these staves, the Program for all of them will change.

If you prefer to set up your MIDI instruments so that their programs are already selected for 
each MIDI channel, you can ignore the Prog. settings in the Instrument List. Finale will only 
transmit these Program settings to the MIDI instruments if Send Patches Before Play is 
selected in the Instrument List window.

• GM. This column displays the General MIDI descriptive name of the Program number. By 
clicking on the name, you produce a drop-down list containing all of the names. Select the 
desired GM name to have Finale fill in the matching Program Number.
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• View by Staves • View by Instruments. When View by Staves is selected, the information in 
the Instrument List is organized by staves, as they appear in the score.

You can also re-organize the list so it’s displayed by Instrument (by selecting View by Instru-
ments). By doing so, you can see which staves and layers have been assigned to each Instru-
ment.

• Play All • Play None. These buttons turn the squares in the Play column for all staves (and 
layers) on or off, respectively. 

• Solo All • No Solos. These buttons turn the black circles in the Solo column for all staves (and 
layers) on or off, respectively. 

• Edit Instrument. Select an instrument and click the Edit Instrument button, or ctrl-click in 
the Chan., B, Prog., or Instrument columns to display the Instrument Definition dialog box, 
where you can change all aspects of an instrument’s definition, including the bank or program 
change information.

• New Instrument. To create a new Instrument, click this button. The Instrument Definition 
dialog box appears. Here you can create the new instrument name, as well as define the instru-
ment’s channel and Patch information. Note, this button only appears when View by Instru-
ments is selected in the Instrument List window.

• Delete Instrument. To delete an Instrument, select an Instrument name in the left column, 
and then click Delete Instrument. The Instrument is removed from the list. This button is only 
available when View by Instruments is selected in the Instrument List window.

• Send Patches Before Play. Select this option if you want Finale, just before it begins play-
back, to transmit any patch information specified in the Instrument List to your MIDI instru-
ments.
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You probably won’t want to select this option, however, if you prefer to assign programs to 
MIDI channels on your MIDI instrument before you begin playback, instead of letting Finale 
do it. If you select Send Patches Before Play, Finale will wipe out any MIDI channel/patch 
configurations you’ve set on your MIDI instrument, and use the information defined in the 
Instrument List window for playback.

• Auto-create Instruments. This checkbox only appears when View by Staves is selected. If 
this checkbox is selected, Finale will automatically create a new Instrument for each new staff 
created. You can rename them or change their channel and patch assignments by clicking View 
by Instruments and editing the various boxes.

If this box isn’t selected, then Finale will assign every staff in your score to the same Instru-
ment, channel, and patch (until you change them by creating new Instruments).

Note, to have this function take effect, you must first select the checkbox, then create new 
staves. If you create new staves then select this button, all the staves will be assigned to the 
same instrument.

Instrument Definition dialog box
How to get there
Choose Instrument List from the Window Menu, if it isn’t already selected. The Instrument List 
window appears on your screen. Choose New Instrument from the instrument drop-down list 
(with View by Staves selected), or click the New Instrument button (with View by Instruments 
selected). 

To change the definition of an existing instrument, select the instrument in the Instrument List 
window, then click the Edit Instrument button. Or, click the Bank (B) column or ctrl-click the 
Channel (Chan.), Bank (B), Program Change (Prog.), or Instrument Name (Instrument) columns.

What it does
Use this dialog box to create new instruments and edit existing instruments, as well as to specify 
or modify channel, bank, and program change information for an instrument. 
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• Instrument Name. Enter a name for a new instrument, or change the name of an existing 
instrument.

• Channel. Enter the number of the MIDI channel the selected instrument will use for play-
back. Any layers or staves assigned to this instrument will automatically play back using that 
MIDI channel.

• Patch: Program Change • Bank Select 0, Bank Select 32, Program Change • Bank Select 
0, Program Change • Bank Select 32, Program Change • Program Change, Program 
Change. This drop-down list lists the types of bank and program changes available in Finale. 
Finale supports bank changes according to the MIDI Specification and to the implementations 
of several manufacturers. Choose the method which matches your MIDI gear. (Check your 
manuals to see if the manufacturer of your MIDI gear supports banks, and if so, which method 
is supported. Or, refer to the APPENDIX-BANK SELECT, which provides a list of MIDI instru-
ments and the bank select method they use.)

The first option corresponds to the simple program change. The remaining options provide 
bank support. “Bank Select 0, Bank Select 32, Program Change” is the standard method of 
doing bank select; first controller 0 (C0), then controller 32 (C32) are sent with their respec-
tive values (these two controllers determine the bank), then a program change (PC) is sent. 
The next two drop-down list selections are variations on the standard. In both cases, only one 
of the controllers is sent with its value. The last case, Program Change, Program Change, is 
bank select done by two standard program changes.

• Bank Select 0. This text box may be disabled depending on the selection in the Patch drop-
down list. If available, enter the value of the bank you want selected.

• Bank Select 32. This text box may be disabled depending on the selection in the Patch drop-
down list. If available, enter the value of the bank you want selected.

• Program Change. Enter the number of the program change (the number of the instrument 
sound) that you want Finale to send. 
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Note: If you prefer, you can directly enter the program change number into the Instrument 
List’s “Prog.” (program change) column, instead of entering it here.

• General MIDI. Select the General MIDI patch from this drop-down list to automatically set 
up the Banks and Program Change for the selected instrument.

• OK • Cancel. Click OK (or press enter) to confirm or Cancel to disregard your changes.

Instrument lists
To assign staves to MIDI channels
• From the Window Menu, choose Instrument List. The Instrument List window appears. 

Down the side of the screen you see the names of the staves in your document. At the right 
side of the screen, you can see the Instrument each staff is assigned to (and the MIDI channel 
that Instrument uses).

• To change the MIDI channel for a staff, click in the Chan column across from its name, 
and type a new channel number. Keep in mind that you’re now changing this Instrument’s 
channel; if any other staves share the same Instrument, their MIDI channel numbers will 
change, too.
You can also change the channel for an individual Layer of a staff. To do so, click the arrow to 
the left of the staff name; Finale displays new rows of information that correspond to the 
staff’s Layers. Change any Layer’s Instrument assignment, using the Instrument drop-down 
list across from its name, or just edit its Channel. If you want the Layers to have different 
MIDI channels, remember to assign them to different Instruments first.

• Click the staff name’s upward-pointing arrow to “collapse” (hide) the list of layers. 

If you plan to re-use a typical patch/channel configuration, consider defining it, and naming it, 
as an Instrument. To do so, choose New Instrument from the Instrument drop-down list across 
from any staff name. Enter the patch and channel numbers, and click OK. Then, the next time 
you want to re-create a particular channel and patch configuration for a particular staff, your 
new Instrument's name will appear in the drop-down list for quick access.

To load an Instrument Library
One of the advantages of Finale’s Instrument List is that, with a single command, you can config-
ure a score with an elaborate MIDI setup, complete with channels, patch numbers, and their spe-
cific program names (“Breathy Winds.” for example).

• Choose Open Library from the File Menu. The Open Library dialog box appears.

• Navigate to your Libraries folder. Double-click the Instrument library you want to open. 
We’ve provided Instrument libraries for several popular MIDI instruments. You can, of course, 
create your own.

Once you’ve loaded a library, open the Instrument List. When you click the Instrument drop-
down list (in the Instrument column across from a staff name), you’ll see a list of a dozen or 
more Instruments, each set up to match the names and patch information on your MIDI Instru-
ment. Simply choose a program name to assign it to a staff. (You can view the choices more 
clearly if you select the View by Instruments button.)
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If you customize a MIDI configuration, or own a MIDI instrument for which we haven’t pro-
vided a library, it’s easy to create your own. Using the New Instrument command in the Instru-
ment drop-down list you can create several Instrument name/channel/patch setups. When 
you’re finished, choose Save Library from the File Menu, select Instruments, and click OK. 
Load this library the next time you want a quick way to assign channels and sounds to the 
staves of a score (see SAVE LIBRARY DIALOG BOX and OPEN LIBRARY for a more complete 
discussion of libraries).
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